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Chapter 1. Getting to know iSeries Navigator

iSeries{™) Navigator is a powerful graphical interface for Windows™ clients. With iSeries Navigator, you
can use your graphical interface skills to manage and administer your servers.

To learn more about iSeries Navigator, do the following:

[Chapter 2, “What’s new for iSeries Navigator in V5R3,” on page 5
See a summary of the new and changed information in the V5R3 Information Center for iSeries
Navigator.

[Chapter 3, “Print this topic,” on page 7|
Download and print a PDF of the iSeries Navigator topic.

|Chapter 4, “iSeries Navigator - Functions by Release,” on pagﬂ

When you are using V5R3 iSeries Navigator, you will find that the functions available for any iSeries
server you are connected to are dependent on which version of 0S/400® is running on that server.
See this table to find out which functions are available for each release of OS/400.

|Chapter 5, “Requirements for installing iSeries Navigator,” on page 17|
Review the PC hardware and software requirements to install iSeries Navigator.

[Chapter 6, “Installing iSeries Navigator,” on page 19
Get started managing and administering your server from your PC. Once installation is complete,
task-based information is available in the iSeries Navigator online help.

[Chapter 7, “Working with iSeries Navigator,” on page 21|
See an overview of the capabilities that iSeries Navigator provides, which are covered in the
Information Center.

[Chapter 8, “Related information for iSeries Navigator,” on page 23
Follow the links in this topic to find related technical information in IBM” Redbooks™, in other
Information Center topics, and on IBM Web sites.

Here is an example of the iSeries Navigator main window:

© Copyright IBM Corp. 1998, 2004 1
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From this example, you can see the iSeries Navigator hierarchical tree view in the left pane of the window.
It provides a familiar user interface for those experienced in using graphical interfaces. It also decreases
the need for users to learn the character-based interface. iSeries Navigator functionality includes system
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navigation, configuration, systems management, and monitoring capabilities. For step-by-step instructions
on how to perform tasks in iSeries Navigator, see the iSeries Navigator online help.

Chapter 1. Getting to know iSeries Navigator 3



4  iSeries: iSeries Navigator



Chapter 2. What’s new for iSeries Navigator in V5R3

New and changed information in the V5R3 Information Center for iSeries{™ Navigator includes:

[Chapter 6, “Installing iSeries Navigator,” on page 19|
Updated PC hardware and software requirements.

[Chapter 4, “iSeries Navigator - Functions by Release,” on page_9|

Formerly available from the iSeries Navigator Web page, this table (which shows what functions are
available for each release of 0S/400(?) is now part of the iSeries Information Center. When you are
using iSeries Navigator, you will find that the functions available for any iSeries server you are
connected to are dependent on which version of OS/400 is running on that server.

[iSeries Navigator tasks on the Web|

You can now access and perform a subset of iSeries Navigator tasks through an Internet Web browser.
The interface may look slightly different, but the tasks you can perform are the same. The following
iSeries Navigator functions are available to work with on the Web:

— Messages, User Jobs, and Printer Output (in Basic Operations)

— Active Jobs, Server Jobs, Output Queues, and Subsystems (in Work Management)
— System Values and Time Management (in Configuration and Service)

— Database Objects in (Databases)

Intelligent Agents console|

System administrators can now manage one or more ABLE (Agent Building and Learning Environment)
agents running on a single system or across a distributed platform. This new topic in the iSeries
Information Center provides more information about ABLE agents, setting up your agent environment,
and using the Intelligent Agents console in iSeries Navigator.

In addition to the information in the [Chapter 4, “iSeries Navigator - Functions by Release,” on page 9 table,

see the following for more information about what new functions are available in V5R3 for iSeries

Navigator:

[iSeries'™ Technical Support|

Web site

Look under Library in the left navigation bar, and then under iSeries Technical Overviews, for a more
technical description of the new functions in V5R3.

iSeries Navigator online help

In iSeries Navigator, click Help -> Help Topics -> What’s new? to review all the new functions
available in iSeries Navigator this release.

See also the following topics:

« [iSeries Navigator for Wireless — What's new for V5R3

- [iSeries Navigator tasks on the Web — What's new for V5R3)|

+ [Management Central — What’s new for V5R3?

How to see what’s new or changed

To help you see where technical changes have been made, this information uses:

The ¥ image to mark where new or changed information begins.
The <& image to mark where new or changed information ends.

To find other information about what's new or changed this release, see the [Memo to Users|

© Copyright IBM Corp. 1998, 2004 5
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Chapter 3. Print this topic

To view or download the PDF version of this document, select|Getting to know iSeries Navigator| (about
322 KB).

Other information

You can also view or print any of the following Redbook PDFs:

+ % [Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More] %

+ [Managing OS/400 with Operations Navigator V5R1 Volume 2: Security| %‘

+ |Managing OS/400 with Operations Navigator V5R1 Volume 3: Configuration and Service|'@l

« |Managing OS/400 with Operations Navigator V5R1 Volume 4: Packages and Products@

[Managing OS/400 with Operations Navigator V5R1 Volume 5: Performance Managemenﬂ%

+ |[Managing OS/400 with Operations Navigator V5R1 Volume 6: Networking{%l &

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click any of the PDF links above).

2. ' Click Save Target As... if you are using Internet Explorer. Click Save Link As... if you are using
Netscape Communicator.<%

3. Navigate to the directory in which you want to save the PDF.
4. Click Save.

Downloading Adobe Acrobat Reader

% You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the

[Adobe Web site| (www.adobe.com/products/acrobat/readstep.html) -ﬁf 4%

© Copyright IBM Corp. 1998, 2004
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Chapter 4. iSeries Navigator - Functions by Release

% When you are using V5R3 iSeries{™ Navigator, you will find that the functions available for any iSeries
server you are connected to are dependent on which version of 0S/400® is running on that server. The
following table shows what functions are available for each release of OS/400.

Management Central Description V5R1 V5R2 V5R3
Management Central Multiple iSeries systems management. &

Monitors System Monitors - Monitor real-time performance of
one or more iSeries servers.

Job Monitors - Monitor jobs on one ore more iSeries
servers.

Message Monitors - Monitor messages on one or
more iSeries servers.

QA QS

B2B Activity Monitors - Monitors your B2B
transactions.

File Monitors - Monitors files for any changes, or for
specific text strings.

Graph History - Provides a graphical view of
performance data collected over days, weeks,
months, or years.

Commands Run and save commands.

Packages Create, save, and distribute objects.

Hardware / Software Inventory Collect and display inventory.

Fixes Inventory Manage software fixes (PTFs).

Scheduling Schedule Management Central tasks.

Collection Services Collect performance data.

System Values Display, change, and distribute system values.
Distributed User and Group Create, change, and distribute users and groups.

Administration

Licensed Program Installation  Create LPs and fixes, distribute and install.

(< < < T < < I < < T < T < T < T < < T < < T < <
< I < < T < < T < T < T < T < O < T < < T < < <

QAQQS QGG 0O
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Management Central
Extreme Support

SSL Support

Synchronize Date and Time

Cluster Proven

Synchronize EIM and Kerberos
Configurations

iSeries Navigator for Wireless
iSeries Navigator for Wireless

iSeries Navigator Tasks on the
Web
iSeries Navigator Tasks on the
Web

Intelligent Agents
Intelligent Agent Support

Application Administration
Application Administration

Administration of Plug-ins

Centralized Administration

Basic Operations
Basic Operations

Messages

Printers

Printer Output

10 iSeries: iSeries Navigator

Description
Secure, personalized service and electronic support.

Secure transmissions between a central system and
endpoint systems.

Enhanced SSL and Authentication - sign on to one
system and be recognized by others.

Synchronize date and time system values across a
network of iSeries servers using Compare and
Update System Values.

High availability for Management Central when
running in a cluster environment.

Use the Synchronize Functions wizard to duplicate
your EIM and Kerberos configurations from a model
system to your endpoints.

Description
Remotely monitor system performance and status.

Description

Select iSeries Navigator tasks directly accessible from

a web browser.
Description
Create and manage autonomic Java'™ agents to

maintain your iSeries servers.

Description
Control user’s access to functions.

Control user’s access to iSeries Navigator plug-ins.

Define an administration system to centralize your
Application Administration settings.

Description
Manage lists of messages, printer output, and
printers.

Work with messages.

Manage printers.

Work with printer output.

V5R1

V5R1

V5R1

V5R1

V5R1

V]

V5R1

QQQ

V5R2

V5R2

V5R2

V5R2

V5R2

QA ;dQC
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Management Central

AFP Workbench Viewer

Jobs

Job logs

Command Prompter
Graphical CL Command
Prompter

Work Management
Work Management

Active Jobs

Server Jobs

Job Queues

Description
Cut, copy, paste, drag & drop, printer output.

Displays printer output.

Work with user jobs.

Display job log for a job.

Description
Prompt for CL commands within iSeries Navigator.

Description
Manage system operation and the daily workload on
the system.

Work with active jobs.

Call Stack - View the call stack for an active job.

Library List - View the library list for an active job.

Locked Objects - Work with the object locks for an
active job.

Open Library Objects - View and work with the open
library objects for an active job.

Open File System Objects - View and work with the
open file system objects for an active job.

Elapsed Performance Statistics - Monitor job
performance using Elapsed Performance Statistics.

Threads - Work with threads running under an active
job.

Transactions - Work with transactions attached to an
active job.

Last SQL Statement - Work with last SQL statement
that was run by an active job.

Work with server jobs.

Work with active and all job queues.

V5R1

QA QA AQQiIQFQQQ0
I < < I < B < I < T < R < I < <

QAQ QA QXXX QI Q@00

o

SQQQQQ

V5R2

V]

V5R3

V]
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Management Central
Subsystems

Memory Pools

Output Queues

System Status

Hardware
Configuration and Service

Disk Management

LPAR Configuration
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Description
Work with active subsystems.

Work with memory pools.

Work with all output queues on the system.

Quickly and easily check the status of a system.

Description
Manage hardware and software on your system.

System Values - Work with all system values.

Time Management - Adjust time and manage time
zones.

Hardware Inventory - Display the hardware for the
system.

Software Inventory - Display the software for the
system.

Manage the disk units on your system.

Work with disk unit balancing, status, and capacity.
Manage disk units, HSM, and compression. Add,
move, and remove disk units.

Set up and manage independent disk pools.
Graphical View - Displays all disk units in a parity set,
mirrored pairs, active, and more.

Print the graphical view.

Parity Sets - Start, stop, and resynchronize parity.
Parity Sets - Change parity optimization.

Geographic Mirroring - Mirror independent disk pools

to systems at other sites.

Configure and manage local partitions.

V5R1

V5R1

QQ
<<

S QO QG

V5R2

Q
Q

QA

V5R2

QAR

Q
I I I T < B < T < < < T < < T < < T < < < <
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Management Central

Simple Cluster Configuration

Tape Devices

Network
Network Functions

Windows™ Administration

Enterprise Identity Mapping
(EIM)

Description

Configure and manage two-node clusters.

Support for stand-alone tape devices and tape
libraries.

Description
Manage your OS/400 TCP/IP configuration and other
communications interfaces using wizards, configure

new servers, and start servers in one step when
TCP/IP starts.

Access iSeries Internet applications like IBMT Web
Adminstration for iSeries.

Manage point-to-point communications.

Set up and manage TCP/IP interfaces.

Set up and manage server applications, which
includes: DNS, DHCP, iSeries NetServer, NFS,
DCE, Directory server (LDAP).

Set up and manage IP security.

Set up virtual private networking (VPN).

Manage additional IP interface and line types (PPP
for example) over L2TP and ISDN, WAN and
Circuitless IP.

Manage TCP/IP quality of service.

NetStat - Detailed information for interfaces, routes,
connections, physical interface activity.

Manage your Windows server on an Integrated
xSeries™ Server.

Windows Server Management - Start and stop
integrated Windows servers, status.

Manage users and disk storage for your integrated
Windows servers.

Inexpensive cross-platform single sign-on.

Create and manage mapping policies.

V5R1

V5R1

QA QQQ QdQQ QxdQQ 02
< < I < I < I < T < T < T < T < T < < T < i <
QS QC QS QA QG e@ ¢

V5R2

V]
V)

V5R2

V)

V5R3

V]
v

V5R3
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Management Central

Security
Security

Permissions

Security Policies

Security Configuration Wizard

Users and Groups

SSL Support

Network Authentication Service

Object Signing and Signature
Verification

Database
Database

Multiple Databases

Manage DB2 UDB Objects

Reorganize Tables

14  iSeries: iSeries Navigator

Description
Test EIM mappings.

Support for x.509 and Digital Certificates.

Description
Object authority and security system values.

Manage object authority.

Maintain security and auditing policies.

Configure security.

Manage OS/400 users and groups.

Use SSL to secure iSeries server applications.

Easily create and manage Kerberos tickets to
authenticate users

Create and manage keytab entries.

Description

Administration of DB2(R) Universal Database(TM)

(UDB) for iSeries.

Multiple databases now supported using independent

disk pools.

Work with complex objects, procedures, and
functions.

Tables, views, journals, indexes, and aliases.

Sequence objects, partitioned tables, check pending
constraints, materialized query tables and more.

Objects organized by container.

Stop, resume, and view progress of table
reorganization.

V5R1

V5R1

QQAQQQQ 0
QS QQQQE

V5R1

V]

V5R2

V5R2

S QR Q
I I << I I < TR I < B < < I < I < I < I < <
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Management Central
SQL

Visual Explain

Database Navigator

iSeries Graphical Debugger

Integrated File System (IFS)
Integrated File System

File Shares

Additional Attributes

Virus Scanning

Advanced Function Printing™
(AFPT™)
AFP Manager

Intelligent Routing

Backup
Backup

BRMS
Backup, Recovery and Media
Services (BRMS)

Description

V5R1

Create, save, and run SQL scripts. &

Collect and view SQL performance data using SQL 0

performance monitors.

View the SQL statements used to perform database

actions using Show SQL.

Library support enhanced to support SQL object

schema.

Visual description of queries.

Visual description of your database.

Launch and run from SQL scripts.

Description

Work with the iSeries integrated file system.

Cut, copy, paste, create, and Rename IFS files.

Drag and drop, cut, copy, and paste QSYS objects.

List and work with NetServer File Shares.

Display object attributes.

V5R1

QQAQQQ
QQAQQ G

Provides support for scanning files using third-party

virus scanning software.

Description V5R1
AFP resources, font mapping tables, PSF. 0
Specify any combination of stream file, spooled file, &
or e-mail for PDF output file.

Description V5R1
Schedule backups. 0
Description V5R1

BRMS Licensed Program (iSeries Navigator plug-in). 0

V5R2

V5R2

V5R2

V5R2

V)

V5R3

S Q: QA :; QS QXA QQ2N0Q0
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Management Central

Application Development
Application Development

Plug-in Support
Java

C++

Visual Basic

{{
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Description V5R1
Global policy properties

View and save HTML-based reports.

Reclaim media

Manage devices

Backup policy omits of folders, libraries, and library

objects.

Restore printer output and archive objects

Description V5R1
Work with application development tools. &
Description V5R1

Create plug-ins using Java.

Create plug-ins using C++.

Create plug-ins using Visual Basic.

QA Q

V5R2

V5R2

QA Q

V5R3

QAQ:; Q0 QQQQ0



Chapter 5. Requirements for installing iSeries Navigator

% To install and use iSeries™ Navigator, your PC must be running one of the following Windows®
operating systems:

Windows NT® 4.0

Windows 2000

Windows XP

Windows Server 2003 (32-bit PC)
Windows Server 2003 (64-bit PC).

See |Prerequisites to set up the PC for iSeries Access for Windows|for the processor, memory, and service
pack level requirements for each operating system. <%

© Copyright IBM Corp. 1998, 2004 17
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Chapter 6. Installing iSeries Navigator

All iSeries™ Navigator components are packaged with [Series Access for Windows| Assuming that your
PC meets the [Chapter 5, “Requirements for installing iSeries Navigator,” on page 17| your first step is to
install the iSeries Navigator components when you install iSeries Access for Windows on your PC.

Note: You need to have iSeries Access for Windows installed on the system from which you install
iSeries Navigator. However, iSeries Access for Windows is not required on the systems that you connect
to with iSeries Navigator. The only software requirement for these systems is the OS/400 host servers
option (Option 12 when you install the 0S/400®® operating system).

% To install iSeries Navigator on your PC, follow the instructions to finstall iSeries Access for Windows on
lyour PQ| <% If you are installing iSeries Navigator for the first time, be sure to make these selections:

1. Select the Custom installation option during iSeries Access for Windows installation.

2. In the Component Selection window, only some of the subcomponents of iSeries Navigator are
preselected to be installed. Click the gray box next to iSeries Navigator to remove the default
selections.

3. Click the box next to iSeries Navigator again. This selects all of the individual iSeries Navigator
subcomponents.

4. Deselect any subcomponent that you do not want installed.

If you have a previous release of iSeries Navigator installed on your PC, you can choose the Basic
Upgrade installation option to upgrade your previously installed components to the new release. To add or
remove components, choose Selective Upgrade.

Installation tips:

» If you select the Typical installation option, only the following iSeries Navigator components will be
installed:

— iSeries Navigator base support
— Basic operations (messages, printer output, printers, and jobs)
» To install additional components after you install iSeries Navigator, use iSeries Access Selective Setup.

 If you are having trouble reading the fonts on some windows, try using a screen resolution of 1024x768
or higher.

Once you have completed installing iSeries Navigator, you will need to add server connections. To add
connections to iSeries Navigator:

1. Double-click the iSeries Navigator icon on your Windows desktop.
2. Click Yes to create a connection.

3. Follow the instructions in the Add Connection wizard.

4

To add another server connection, click File -> Connection to Servers -> Add Connection in the
iSeries Navigator main window.

Once you have iSeries Navigator up and running, refer to the iSeries Navigator online help for specific
task-based information.

© Copyright IBM Corp. 1998, 2004 19
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Chapter 7. Working with iSeries Navigator

iSeries™) Navigator provides a powerful suite of functions to handle your system administration tasks.

Once you have[Chapter 6, “Installing iSeries Navigator,” on page 19,|use the online help for step-by-step

instructions for all the individual tasks that you can do “the GUI way” in iSeries Navigator. In the main
iSeries Navigator window, just click Help -> Help Topics -> What can | do with...?

For links to related conceptual information in the Information Center, keep reading!

iSeries Navigator concepts

Manage multiple systems

Manage logical partitions

% Manage your hardware

Secure your network

Work with database records

© Copyright IBM Corp. 1998, 2004

The Management Centrall technology, which is an integral
part of iSeries Navigator, allows you to manage tasks
across one or more servers simultaneously. Simplify your
systems management with task scheduling, real-time
performance monitoring, managing fixes (or PTFs),
distributing objects, managing users and groups, running
commands from a central system, and much much more.

Use iSeries Navigator to access your logical partition
information, change logical partition configuration, manage
security, and change processing resources without
requiring a system restart. On an iSeries server, you can
use iSeries Navigator, DST, and SST to
}} If you are working with partitions on

an (&' SETYET B 5xxx, see |Partitioning the server for
more information. &

Use iSeries Navigator to configure, protect, and manage
all of yourIdisk units and disk pools,|as well as work with
mirroring and parity protection. iSeries Navigator also
allows you to view all stand-alone devices as well as all
the tape resources and cartridges within your

Using iSeries Navigator, you can duplicate tapes,
display or print volume labels, eject a tape from a tape
library, format a tape, make a tape cartridge or device
(vary it on), make a tape device unavailable (vary it off),

print save-or-restore-tape information, print volume
contents, and reset tape resources. <,

Network security] means that your customers, employees,

and business partners can obtain the information that they
need to do business with you in a secure environment.
iSeries Navigator has several integrated features that will
help build a strong defense against the security risks you
may encounter along the way. Use iSeries Navigator to
configure everything from your basic system security
policy to secure end-to-end VPN connections, filter rules,
address translation, SSL, enterprise identity mapping, and
much more.

You can perform many of your database tasks using
iSeries Navigator. These tasks include creating and
maintaining database objects, inserting or changing data,
monitoring and analyzing query performance, and creating
a map of your database. See [Getting started with iSeries|
[Navigator Database| for more details.

21



Connect your network

Manage your system workload

Limit application availability

22
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Use the Network component of iSeries Navigator to
configure and manage network communications on your
server. Find wizards to easily configure the interfaces,
routes, and servers that are necessary for network
communications. Verify connectivity using the PING and
trace route utilities. Then, choose from a variety of
functions to customize the network; for example, you may
select IP policies to control and secure your network traffic
using or or choose [Remote Access Services]to
create point-to-point connections. See |Networking| for
detailed information about various networking technologies
that you can use on the iSeries.

[System jobs]are created by the operating system to
control system resources and perform system functions.
System jobs run when the iSeries server starts, without
user input. These jobs perform a variety of tasks from
starting the operating system, to starting and ending
subsystems, to scheduling jobs. See for

information about managing jobs.

|Application Administration|allows administrators to limit or
grant access to functions, including several iSeries
Navigator functions, and other applications for the users
and groups on a specific iSeries server. Administrators
can also centrally manage many of the properties used by
iSeries Access for Windows clients and use the advanced
Application Administration settings to centrally control
environment, password, connection, service, and
language settings.




Chapter 8. Related information for iSeries Navigator

Listed below are the IBM® Redbooks™ (in PDF format), Web sites, and Information Center topics that
relate to the iSeries'™ Navigator topic. You can view or print any of the PDFs.

Redbooks

« % [Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More] %

« [Managing OS/400 with Operations Navigator V5R1 Volume 2: Security| %

[Managing OS/400 with Operations Navigator V5R1 Volume 3: Configuration and Service|%l

+ |Managing OS/400 with Operations Navigator V5R1 Volume 4: Packages and Products[@

+ |Managing OS/400 with Operations Navigator V5R1 Volume 5: Performance Managemenﬂ&

[Managing OS/400 with Operations Navigator V5R1 Volume 6: Networkind@ £

Web sites

iSeries Navigator home pagel-'-ﬂﬁr .

Other Information Center topics
+ [iSeries Navigator for Wireless| (about 650 KB)
« [iSeries Navigator tasks on the Web| (about 150 KB)
+ [Application Administration| (about 200 KB)
+ [Management Central (about 250 KB)
— [Performance] (about 1100 KB)
— |Software and licensed programs| (about 350 KB)
+ [Developing iSeries Navigator plug-ing (about 360 KB)

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click any of the PDF links above).

2. 3 Click Save Target As... if you are using Internet Explorer. Click Save Link As... if you are using
Netscape Communicator.«x

3. Navigate to the directory in which you want to save the PDF.
4. Click Save.

Downloading Adobe Acrobat Reader

% You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the

[Adobe Web site| (www.adobe.com/products/acrobat/readstep.html) 'ld’ L

© Copyright IBM Corp. 1998, 2004 23
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not give you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

500 Columbus Avenue

Thornwood, NY 10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation

Licensing

2-31 Roppongi 3-chome, Minato-ku

Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS 1S” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer
of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation

Software Interoperability Coordinator, Department 49XA

3605 Highway 52 N

Rochester, MN 55901
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.
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The licensed program described in this information and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or any
equivalent agreement between us.

Trademarks

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:

Advanced Function Printing

AFP

' SErver
eServer
IBM

iSeries
0S/400
Redbooks
xSeries

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions for downloading and printing publications

Permissions for the use of the publications you have selected for download are granted subject to the
following terms and conditions and your indication of acceptance thereof.

Personal Use: You may reproduce these Publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
Publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these Publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of these
Publications, or reproduce, distribute or display these Publications or any portion thereof outside your
enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the Publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the Publications is detrimental to its interest or, as determined by IBM, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations. IBM MAKES NO
GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE
PROVIDED "AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.
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All material copyrighted by IBM Corporation.

By downloading or printing a publication from this site, you have indicated your agreement with these
terms and conditions.
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